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Preface 
The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 
Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web 
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available 
on your network from which you can access the Agile PLM documentation (PDF) files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > Manuals 
in both Agile Web Client and Agile Java Client. If you need additional assistance or information, 
please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Agile Support about a problem with an Agile PLM manual, please have the 
full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  
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Chapter 1 

Introducing Product Quality Management 
This chapter includes the following: 

� What Is Agile Product Quality Management? ...................................................................................................... 1 
� Product Service Requests (PSRs)....................................................................................................................... 2 
� Quality Change Requests (QCRs)....................................................................................................................... 3 
� Quality Tracking Roles......................................................................................................................................... 4 

 
 

What Is Agile Product Quality Management? 
Agile Product Quality Management (PQM) comprises a comprehensive set of tools that allows 
corporations to track and manage data about product quality across the enterprise. This includes 
customer complaints, product and manufacturing defects, field failures, and enhancement and 
corrective and preventive actions requests. Agile PQM closes the support loop by unifying the 
company’s customer service, field sales, manufacturing, and engineering organizations, and by 
tightly linking the company to its customers and partners. 

As competition increases, customers are demanding quality product on time and at a lower cost 
while the product lifecycles shorten. The benefits that Agile PQM features offer to improve your 
organization’s operations and save time and money are: 

à Integration with external enterprise Customer Relationship Management (CRM) systems — the 
ability to import customer complaints, manufacturing issues, and additional quality-related 
information from other enterprise applications streamlines the quality tracking process and 
offers a central repository for tracking product quality data. 

à Improved product quality — tracking defects, finding trends, and determining the root causes of 
defects in a timely manner are the keys to effective defect reduction and improved product 
quality. 

à Improved customer satisfaction — the ability to track problem reports and customer complaints 
lets you respond to customers and resolve problems quickly. 

à Lower production, repair costs, and warranty costs — tracking and correcting defects can help 
reduce the scrap, cycle time, and costs associated with rework and repair. 

à New features enable compliance with ISO-9000, FDA, and other regulations. 

Note Your organization’s license must include use of the quality tracking features to access the 
options described in this manual. 

The Agile PQM solution is divided into Product Service Requests (PSRs) and Quality Change Requests 
(QCRs). PSRs are used to manage problem reports and non-conformance reports. QCRs are used 
to manage and associate the problem reports with audits and corrective and preventive actions 
(CAPAs). 

Customers and Suppliers are also involved in the Agile PQM solution. Both customers and suppliers 
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can submit PSRs. 

The following figure illustrates how quality data flows from different sources to PSRs and QCRs. 

 

ber 

CRs to 
cifications or any other specific quality issues. 

Problem Reports (PRs) 

r’s perspective. A customer, field service representative, or supplier may submit a problem 

 other than the lock, but this will not be known until your organization investigates the 

 problem. The user with the Quality Analyst role oversees the 

lem reports from different CRM systems. 

Non-Conformance Reports (NCRs) 
 

uirements in one or more products. Non-

Control department samples a subset of materials to identify deviations from the specifications. 

 

Product Service Requests (PSRs) 
You can use a Product Service Request (PSR) to report quality incidents or to aggregate a num
of other PSRs. The Product Service Request class includes Problem Reports (PRs) and Non-
Conformance Reports (NCRs). You use PRs to report any generic quality incidents and N
report material deviations from the spe
 

A Problem Report contains a basic description of a problem, issue, or incident that occurred, from the 
custome
report.  

A problem reported by the customer need not necessarily be the actual cause. For example, a 
problem report might state that the CD drive does not stay locked into the computer case, and it 
might state that the cause of this problem is a malfunctioning lock. The actual cause may be 
something
problem. 

Problem Reports can be routed for investigation through a workflow. The investigating team 
determines the root cause of the
processing of problem reports. 

You can use Agile Import or the Agile SDK to import prob
 

A customer, field service representative, or supplier may submit a Non-Conformance Report (NCR) to
report a basic material deviation from specifications or req
Conformance Reports can also be routed for investigation. 

NCRs are typically used in incoming lot inspections or in testing processes, where the Quality 
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Quality Change Requests (QCRs) 
The Quality Change Request (QCR) class is used to create and manage Audits and Corrective and 

aggregate problems into a routable quality record, perform root-cause 
 

à gregate problems related to products, documents, 

à 

ilure analysis (Quality 
ntative action (Quality 

le, you receive items from your supplier, and when checking the quality of the items, you 
efective item. To take corrective action, you create a QCR for the defective item and 
CR for review and approval. After the quality change request is approved, you can route 

gh the change to make sure that the defect is rectified and changed to new revision of 

ng 

Preventive Actions (CAPAs). An audit is the proactive process of verifying compliance with quality 
requirements. The CAPA is a formal process of addressing any generic quality problems and 
analyzing the root causes so you can implement corrective and preventive actions. 

The QCR allows you to 
failure analysis, and drive the problems to closure using standard CAPA (corrective and preventive
actions) procedures. The CAPA may result in changes to a product, process, or supplier. 

You can use QCRs to: 

Create and manage quality records that ag
suppliers, and customers. 

Provide a means for driving quality-related changes by creating changes such as ECOs, 
MCOs, ECRs, stop ships, and deviations. 

à Route change requests for review and approval, thereby enabling communication and 
collaboration between the originator (Quality Control), root-cause fa
Control and Engineering), resolution (Engineering), corrective/preve
Management), communication (customers and suppliers) and verification (compliance/audit). 

à Provide an audit trail between problems, corrective and preventive actions, and engineering 
changes that enables internal and external compliance processes. 

For examp
identify a d
route the Q
the item throu
the item. 
 

Audit 
An Audit is a pro-active process of verifying compliance with quality requirements. 

The Default Audits workflow has different statuses from other default workflows. The followi
diagram shows the Default Audits workflow statuses and typical tasks related to audits: 

 
 

CAPA 
You can use corrective and preventive actions (CAPAs) to address any generic quality problems for 
one or more PSRs. A CAPA could result in the creation of one or more changes that lead to fixing 
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the problems. A CAPA is a routable object and is controlled by a workflow. 

The Default CAPA workflow has different statuses from other default workflows. The following 
diagram shows the Default CAPA workflow and typical tasks related to audits: 

 

age their resolution. 

ntly on your system. For details about 
Agile PLM roles, see the Agile PLM Administrator Guide. 
 

 

Quality Tracking Roles 
Product Quality Management provides the following roles: 

à Quality Analyst — Allows users to submit Product Service Request and man

à Quality Administrator — Allows users to manage Quality Change Requests. 

Your Agile Administrator may have set up the roles differe
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Quality Tracking Process 
The Product Quality Management solution is flexible. You can adapt it to fit your business 
processes. The following diagram illustrates one example of a quality incident process. Following 
the diagram is a description of each numbered step. 

 

The steps outlined in the preceding figure are explained below: 

1. Two customers - Customer 1 and Customer 2 —report quality incidents. 

2. The support representative creates problem service requests (PSRs) for the reported incidents: 
PSR-1, PSR-2, PSR-3 for Customer 1 and PSR-1, PSR-2, PSR-3 for Customer 2. These problem 
reports are submitted to the Quality Analyst. 

3. The Quality Analyst reviews all the PSRs from different customers. All the PSR incidents from 
different customers appear to be related, so the Quality Analyst aggregates all these related 
PSRs into one PSR and creates PSR-4. Then PSR-4 is routed through the workflow for further 
processing. 

4. The Quality Administrator creates a quality change request, QCR-1. The QCR includes a list of 
the items that it affects. The QCR is routed, and engineering team determines that the request 
is valid and merits a change to either an ECO, MCO, ECR, stop ship or deviation depending on 
the problem. 

5. A change is created to address the problem. The Change Analyst routes the change through 
the workflow. 

6. The change is eventually implemented, fixing the original problem. The Change Analyst sends 
a notification to the Quality Administrator, who then decides whether the change did indeed 
address the problem documented in the QCR. 

7. The quality administrator takes action to close the QCR. 
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8. PSR-4 is automatically closed through the relationships specified on the Relationships tab. 

9. All the child PSRs aggregated to PSR-4 are automatically closed based on the specified 
relationships. 

10. The Quality Analyst sends a notification of the problem resolution to Customer 1 and Customer 2. 

The process outlined above is just an example. The flexibility of Agile Product Quality Management 
also allows routable objects to be created without any associated problem reports, and QCRs to be 
created without problem reports. Additionally, multiple incidents may lead to one QCR, but a single 
incident can lead to only one QCR. A QCR may lead to multiple changes (such as ECOs or SCOs), 
or multiple QCRs may lead to one change. 
 

Quality-Related SmartRules 
SmartRules are system wide settings that let you choose how to manage specific behaviors in Agile 
PLM. Your Agile Administrator can modify these settings. The following SmartRules are related to 
Product Quality Management processes: 

à Many Items per PSR 

à Many QCRs per PSR 

à PSR contains Items and Related PSRs 

à Release QCR with unresolved Items 

For a complete description of these and other SmartRules, see the Agile PLM Administrator Guide. 

The PSR Contains Items and Related PSRs SmartRule controls the behavior of the Affected Items tab and 
the Related PSR tab of PSRs. If that SmartRule is set to Allow, PSRs can have both affected items 
and related PSRs. Otherwise, the Affected Items tab and the Related PSR tab are mutually 
exclusive. In other words, if the Affected Items tab lists items, then the Related PSR tab is unavailable; 
and if the Related PSR tab lists PSRs, then the Affected Items tab is unavailable. This allows you to 
choose whether to use a PSR as an aggregation of other PSRs or as a problem report against 
assembly items. 
 

Quality Searches 
To find specific PSRs and QCRs, you can perform a quick search by selecting the required search 
from Quality Searches folder. For example, if you are a Quality Administrator and you want to assign 
all unassigned PSRs to Quality Analysts, you can do a quick search of all unassigned PSRs. 
Sample quality searches are listed below: 

à Unassigned PSRs 

à Open PSRs 

à 

d More Than X Hours Ago 

ubmitted QCRs 

PSRs Submitted More Than X Hours Ago 

à QCRs Submitte

à Closed QCRs 

à Released QCRs 

à Unassigned S
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à O  QCRs 

You will see 

pen

Note es folder only if your Agile PLM Administrator has specified the Quality Search
searches in your profile. 

 

Quality Reports 
Agile PLM provides several standard reports that help you analyze data in Agile Product Quality 
Management. In the navigation pane of Agile Web Client, click Analytics and Reports and select 
Quali r. It lists the following reports: ty Reports folde

Report  name Descr ipt ion 

Failure Trend
. 

ust have a value specified in the Affected Items 

Identifies trends in failure modes over time. Based on the results, you can focus 
corrective efforts on those items that have the greatest effect on product quality
To produce a report of the quantities affected during the specified time period, 
product service requests m
Quantity Affected field. 

Quality Activity  quality change Lists all the quality incidents (product service requests and
requests) that were processed during a specified period. 

Quality Backlog
s but have not moved to another specified 

Counts the quality incidents (product service requests and quality change 
requests) that were at a specified statu
status during a specified time period. 

Quality Cycle Time
PSRs and QCRs) to move from one status to another during the 

nt 

itted to Released each 

Calculates the time it took the specified product service requests and quality 
change requests (
specified period. 

The report lists the requests and shows the average time each PSR or QCR spe
between two statuses per time period. For example, the report indicates the 
average time it took for a PSR or QCR to go from Subm
month during the last year, grouped by a product line. 

Quality Metrics change requests) Shows the quality incidents (product service requests and quality 
that were moved to a specified status during a specified period. 

Each of the Quality reports has a Report Wizard. Step through the wizard, and click Finish on the 

port 

4. Click Quality Activity Reports) lets you search for Product 

6. Click vanced Search to create a new query. Select All Product Service Requests to use all 

final page to display the report. 
 

Running a Quality Re
To run a Quality Report: 

1. Select the report in the Quality Reports folder. The report’s page appears. 

2. Click the Execute button. The Select Layout and Configuration page appears. 

3. Select the layout you want from the list, or use the Layout manager to create a new layout. 

Next ort (except the . The Quality rep
Service Requests to use in the report 

5. Click Saved Search if you want to use a search from the list of available searches. 

Ad
PSRs  

 Page - 7

  

 



Product Quality Management User Guide  
 
 
 

7. Click Next. 
8. port. Examples of other Quality report settings include: 

s. 

Once the report appears, you can print it, export its contents to a delimited text file(CSV) or a 

 

Note The Quality Activity Reports supports the BI Publisher technology since Agile PLM 

Specify other settings for the re
y The time period covered. 
y The time units used in the report. 
y The workflow used in the report. 
y The way to group data to evaluate trend

9. Click Finish to display the report. 

Microsoft Excel workbook, or save it to the Historical Report tab.  

9.2.2.4. 

Important Ensure to enable BI Publisher option to Yes in the Java Client for reports to 
generate multiple output formats.  

To run a Quality Report using a BI Publisher: 

1. Select the report in Quality Reports folder. The report’s page appears. 

2. Click Execute button. The Select Layout and Configuration page appears.  

3. Select the layout you want from the list, or use Layout Manager to create a new layout. 

4. k UsChec e BI Publisher check box to generate reports in multiple output formats.  

Note Enable Automatic Prompting for File Downloads in the custom settings to save the 
generated output formats of a report on to the local machine.   

5. Check Use BI Publisher check box. An additional field with a list of the output formats appears.  

6. Select an output format. You can choose from a l
HTML. 

ist of formats like WORD, EXCEL, PDF and 

7. k SaChec ve the Report check box to save report.  

Note Reports can also be generated using the existing layout.  

8. Click Next. The Quality reports (except the Quality Activity Report) lets you search for Product 
Service Requests to use in the report.  

9. Click Saved 
Search

Search if you want to use a search from the list of available searches. Click Advanced 
eate a new query or select All Product Service Requests to use all PSRs.  

11. Spe

eriod.  
 Such as Year, 

y 
y ate trends: You can choose from a list of attributes 

mary data against the attribute, so that the user gets an 

 to cr

10. Click Next. 
cify other settings for the report. Examples of other Quality report settings include: 

y The time period covered: The period covered between the From and To time. Reports will 
include data received within this p

y The time units used in the report: You can choose from a list of Time Units,
Quarter, Month, Week and Day.  
The workflow used in the report: The workflow used for a PSR or QCR.     
The way to group data to evalu
provided. Report gives a sum
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overview to trends evaluation. 

12. Click Finish to display the report. 

Reports generated can then be printed, or the contents can be exported to a delimited text file
(CSV), or a Microsoft Excel workbook, or saved to the Historical Report tab. Only re
using BI Publisher can be viewed in WORD, PDF, EXCEL or HTML. 

 
ports generated 

s such as items, 
custome

à 

sh a rating or preference for that supplier. 

The Has Qua

 

Quality Tracking Tabs and Fields for Other Objects 
Quality information on certain tabs and fields is linked with information about object

rs and suppliers so that users in your organization can assess the quality risk of 
incorporating certain parts into their designs. 

à The Quality tab for items displays all PSRs reported against that item. 

On the PSRs tab of a customer object, all quality incidents ever reported by a customer are 
listed. This can help you gauge customer satisfaction. 

à On the PSRs tab of a supplier object, all quality incidents ever filed against the supplier are 
listed. This can affect purchasing by helping you gauge the quality performance of a supplier so 
that you can establi

lity icon   indicates the presence of either an open PSR or QCR on
following: 

 an Item. This is 
visible in the 

earch 
ding Changes, 

Part.Manufacturers etc. 
� Change AI tab including ECO, ECR, MCO, SCO, Deviation, and Stopships 
� Item.BOM table which has a pending PSR or QCR. 

 

� Advanced Search Results based on Object type Item including all fields in s
criteria field names like Part.Title Block, P2, Part.Pen
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Working with Product Service Requests 
This chapter includes the following: 

� Creating PSRs..................................................................................................................................................... 11 
� Cover Page Tab of a PSR ................................................................................................................................... 16 
� Affected Items Tab of a PSR ............................................................................................................................... 18 
� Related PSR Tab................................................................................................................................................. 24 
� Relationships Tab ................................................................................................................................................ 28 
� Workflow Tab of a PSR ....................................................................................................................................... 36 
� Attachments Tab of a PSR .................................................................................................................................. 36 
� Submitting and Routing PSRs ............................................................................................................................. 36 

 
 

Creating PSRs 
A PSR object is created the same way other Agile PLM objects are created. You can use the New 
Object button or the Save As feature. You must have the necessary privileges to create a PSR 
object.  

To create a PSR in Java Client: 

1. On the main toolbar, click New Object button . The New dialog box appears. 

2. Select NCR or Problem Report from the Type list. 

3. In the Number field, accept the default number. You can also type a number or click the 
AutoNumber button  to automatically enter the next number.  

4. Click OK. The Cover Page tab is displayed. 

5. Enter the required information on the Cover Page tab. 

6. Click Save. For information about the fields on this tab, see Cover Page Tab of a PSR (on page 
16).  

Agile Java Client creates the PSR and displays the PSR with the Cover Page tab on top. If a workflow 
is not assigned to a PSR then the created PSR will have the Unassigned status. To assign a 
workflow, select a workflow from the Workflow list. 

You can also add multiple items to a PSR (like parts, documents, assemblies). For more information 
about adding items, see Adding Affected Items (on page 22). 

Note Depending on your system's SmartRule settings, the Related PSR tab may be disabled after 
you add items to the Affected Items tab. 

Agile Product Lifecycle Management Page - 11 
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To create a PSR in Web Client:  

1. On the main toolbar, go to Create > Product Service Request > Problem Reports or Non-Conformance 
Reports. 

2. When the PSR Reports Creation wizard opens, select a subclass from the list. 

3. In the Number field, accept the default number.You can also type a number or click the 
AutoNumber button  to automatically enter the next number.  

4. Click Next. The Enter Cover Page Information page appears. 

5. Enter the required information. For information about the fields on this tab, see Cover Page Tab 
of a PSR (on page 16).  

6. Click Finish.  

Agile Web Client creates the PSR and displays it with the Cover Page tab on top. If a workflow is not 
assigned to the PSR, the status is Unassigned. To assign a workflow, click the Edit button on the 
Cover Page and select a workflow from the Workflow list. 

You can also add multiple items to a PSR (like parts, documents, assemblies). For more information 
about adding items, see Adding Affected Items (on page 22). 

Note Depending on your system's SmartRule settings, the Related PSR tab may be disabled after 
you add items to the Affected Items tab. 

 

Creating a PSR 
You can create a Product Service Request (PSR) in various ways, depending on the quality of 
the incidents. Here are two examples: 

à Creating a PSR to report a single quality incident — Suppose you are a Quality Analyst working at a 
computer manufacturing division. A customer calls to report a problem about a CD drive not 
opening, to insert and remove CDs. You create a quality incident for this problem specific to CD 
drive item ( its related parts and documents) and want the QA department to quickly look into 
this incident to see if it is in fact a defect or merely an user error. 

 
  

à Creating a PSR to aggregate multiple PSRs — Suppose you are a Quality Assurance Engineer for a 
certain product. Recently, you have noticed several incoming lots and shipments from your 
suppliers that do not conform to the material specifications. You decide to track down all these 
incidents and create one single PSR to aggregate all the supplier's incidents. 
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The following diagram illustrates the flow: 

 
 

Creating a PSR from Items 
You can create a PSR from items. 

To create a PSR from an item in Java Client: 

1. Open the item from which you want to create a PSR. 

2. Right-click in the item window, and choose Create Product Service Request from the shortcut 
menu. The Create Product Service Request dialog box appears. 

3. Select NCR or Problem Report from the Type list. 

4. In the Number field, accept the default number. You can also type a number or click the 
AutoNumber button  to automatically enter the next number.  

5. Click OK. Enter the required information on the Cover Page tab. 

6. Click Save.  

For information about the fields on this tab, see Cover Page Tab of a PSR (on page 16). 

Agile Java Client creates the PSR and displays it with the Cover Page tab on top. The item appears 
on the Affected Items tab of the new PSR. 

To create a PSR from an item in Web Client: 

1. Open the item for which you want to create a PSR. 

2. On the item page, choose Actions > Create Product Service Request. The Product Service Request 
Creation Wizard appears. 

3. Select a subclass (Problem Report or NCR) from the list. 

4. In the Number field, accept the default number. You can also type a number or click the 
AutoNumber button  to automatically enter the next number.  

5. Click Next. The Enter Cover Page Information page appears. 

Enter the required information. For information about the fields on this tab, see Cover Page Tab 
of a PSR (on page 16). You can assign a workflow to route the PSR through the workflow 
statuses.  

6. If you need to add additional items, click Next or click Finish. 
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Agile Web Client creates the PSR and displays it with the Cover Page tab on top. The item appears 
on the Affected Items tab of the new PSR. 
 

Creating a PSR to Aggregate Multiple PSRs 
You might have created a number of PSRs to deal with multiple problems. You might discover that 
if a particular problem is solved all the related problems for which you have created PSRs would 
also be resolved. You can aggregate other related PSRs that have already been created. The PSR 
you create to solve the related PSRs is considered the Parent PSR, and all the added PSRs on the 
Related PSR tab are considered child PSRs. 

To create a PSR to aggregate multiple PSRs in Java Client: 

1. Open a PSR you want to use as the basis for a new PSR.  

2. Choose File > Save As, or right-click and choose Save As. The Save As dialog box appears. 

3. Select NCR or Problem Report from the Type list. 

4. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button to automatically enter the next number. 

5. Click OK. 

Agile Java Client creates the PSR and displays the PSR with the Cover Page tab on top.  

On the Affected Items tab do NOT add any items. 

6. On the Related PSR tab add related PSRs. 

Once you add related PSRs to this Parent PSR, the Cover Page tab of the child PSR displays 
the Aggregate PSR number with this Parent PSR number.  

7. Click to select the related PSR. 

8. Click Edit Product Service Request. 
9. The Edit Product Request dialog box appears. Specify the PSR Event and PSR Result status. 

10. Click OK. 

Note Depending on your system's SmartRule settings, the Related PSR tab may be disabled after 
you add items to the Affected Items tab. 

 

Field  Completed  Conta ins . . .  

PSR Event Manually The status of the Parent PSR that triggers an automated workflow 
event. 

Select an available status from the drop-down list. You can specify the 
status only when the PSR has a workflow assigned. When this event 
occurs, it means that this PSR has reached the specified status.  

Note: You can specify the PSR Event status only when both objects 
(parent and child) are assigned a workflow on the Cover Page tab. 
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Field  Completed  Conta ins . . .  

PSR Result Manually The status to which the related PSRs are promoted when the event 
status is reached. Select an available status from the list. You can 
specify the status only when the PSR has a workflow assigned. 

When the Parent PSR reaches the status in the PSR Event field, then 
the status of the related PSR is automatically moved to the specified 
result status in this field. 

Note: You can specify the PSR Event status only when both objects 
(parent and child) are assigned a workflow on the Cover Page tab. 

To create a PSR to aggregate multiple PSRs in Web Server: 

Open a PSR you want to use as the basis for a new PSR. Choose Actions > Save As. The Save As 
page appears.  

1. Select NCR or Problem Report from the Type list. 

2. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button to automatically enter the next number. 

On the Add Affected Items page, do NOT add any items.  

3. Click Next. 
4. On the Add Related Product Service Requests page, click Add to add all the related PSRs. 

5. After you add related PSRs to this Parent PSR, the Aggregate PSR Number column for each 
PSR on the Related PSR tab displays the number of the Parent PSR. On the Cover Page of the 
child PSRs, the Aggregate PSR Number field is automatically filled in by this Parent PSR 
number. 

6. Click Finish.  

The Agile Web Client creates the PSR and displays it with the Cover Page tab on top. 

After you add related PSRs to this Parent PSR, the Aggregate PSR Number column for each PSR on 
the Related PSR tab displays the number of the parent PSR. On the Cover Page of the child PSRs, 
the Parent PSR number automatically fills in the Aggregate PSR Number field  

Note Depending on your system’s SmartRule settings, the Affected Items tab may be disabled 
after you add related PSRs.  

 

Creating a PSR Using Save As 
You can use Save As to create a PSR. Save As copies data from a field in the existing object to the 
same field in the new object. If a field or list value in the existing object is not available in the new 
object, then that field or list value is not copied to the new object. Since Page Three data applies to a 
specific subclass only, if you use Save As to create a new object of a different subclass, the Page 
Three data is NOT copied to the new object. 

To create a PSR using Save As in Java Client: 

1. Open a PSR you want to use as the basis for a new PSR.  

2. Choose File > Save As, or right-click and choose Save As. The Save As dialog box appears. 

3. Select NCR or Problem Report from the Type list. 
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4. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button  to automatically enter the next number. 

5. Click OK. 

Agile Java Client creates the PSR and displays the PSR with the Cover Page tab on top. 

6. Make appropriate modifications to the tabs, and click Save. 

To create a PSR using Save As in Web Client:   

1. Open a  PSR you want to use as the basis for a new PSR. 

2. Choose Actions > Save As. The Save As page appears. 

3. Select NCR or Problem Report from the Type list. 

4. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button  to automatically enter the next number. 

5. Click Save. The new object opens. 

6. Make appropriate modifications to the tabs, and click Save. 

Note In general, you should not use Save As to create an object in a different class or subclass 
from the original object. The different classes or subclasses may not have the same tabs 
or defined fields, and you may lose access to some data in the newly created object. 

The following fields are copied to the new PSR: 

Fie lds  copied  f rom o ld ob ject  Automat ica l ly  generated  f ie lds  

Category, PSR Type, Problem Description, Severity, Product 
Line(s)

Originator

Page Two and Page Three flex fields. Date Originated 

All item information is copied from the Affected Items tab. Status field is set to Unassigned by 
default. 

All attachments are copied from the Attachments tab.  

History tab reflects the source and target objects.  

If the Agile PLM Administrator has set the appropriate preferences, fields in the optional Page Two 
and Page Three sections are copied to the new PSR. For information about the behavior of Page 
Two and Page Three fields in your Agile PLM system, see your Agile PLM Administrator. 
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Cover Page Tab of a PSR 
The following table provides information about working with the tabs for product service requests 
and describes the fields on the PSR Cover Page tab. 

Field  Completed  Conta ins . . .  

PSR Number Automatically,  
when created. 

The number assigned to the PSR when you 
create it. 

For a problem report, the number is prefixed 
with PR. 

For non-conformance report, the number is 
prefixed with NCR. 

PSR Type Automatically,  
when created. 

The type (subclass) selected when you create 
the PSR. 

Category Manually The list of categories defined by the Agile PLM 
Administrator, for example: 

Customer Complaint 
Audit - External 
Preventive Action 

Description Usually manually; can  
contain a default. 

Maximum number of bytes is set by the Agile 
PLM administrator; up to 4000 bytes, including 
spaces and carriage returns (which count as two 
bytes). 

Customer Manually The list of customers associated with this PSR. 

Supplier Manually List of suppliers who initiated the incident or are 
the cause of the incident. 

Severity Manually The list of severities defined by the Agile PLM 
administrator. 

Disposition Manually The list of dispositions defined by the Agile PLM 
administrator. 

The Disposition field displays a code that 
represents the way in which a PSR is being 
resolved. Examples of dispositions are Replace 
Component and Rework to Spec. 

Expected 
Resolution Date

Manually Expected problem resolution date. 

Quality Analyst May be provided automatically by 
the workflow; otherwise selected 
manually from a list. Departments 
appear first in the list, followed by 
individual user names. 

The default quality analyst. 
If the workflow is defined to notify the default 
quality analyst, the department or user in this 
field receives notifications about the PSR. If this 
field is left blank, then the notifications are sent 
to every quality analyst on the list. If the 
notification definition in the workflow is blank, no 
notifications are sent. 
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Field  Completed  Conta ins . . .  

Workflow If more than one workflow applies 
to the PSR, the workflow is 
selected manually; the workflow 
selection can be changed as long 
as the PSR is in the Pending type 
status. Selecting the blank field in 
the Workflow switches the PSR to 
the Unassigned status. 

If no workflow is assigned, and you 
move the PSR to the next status 
from the Unassigned status, you 
are prompted to select a workflow. 

The name of the workflow being used to move 
this PSR through the quality tracking process. 

Status Automatically, when created; 
updated as the PSR moves 
through the assigned workflow. 

Workflow status. If no workflow has been 
selected, this field is Unassigned. 

Originator Automatically, when created. The default creator of the PSR. The list of other 
problem report originators. 

Date Originated Usually automatically, when 
created. 

The date the PSR was created. 

Date Submitted Automatically generated based on 
workflow status. 

The date when the PSR moves to the Submitted 
status in the workflow. 

Date Released Automatically generated based on 
workflow status. 

The date when the PSR moves to the first 
Released status in the workflow. 

Final Complete 
Date

Automatically generated based on 
workflow status. 

The date when the PSR moves to the Complete 
status in workflow. 

Aggregate PSR 
Number

Automatically filled in when PSR(s) 
are added to the Related PSR tab.  

For example, if PSR005 lists 
PSR003 and PSR004 on the 
Related PSR tab, then on the 
Cover Page tab of PSR003 and 
PSR004, PSR005, the parent, will 
appear in the Aggregate PSR 
Number field. 

This number is automatically filled in with the 
parent PSR number. 

For example: For a single problem, many quality 
incidents from your suppliers are already 
created. You decide to track down all these 
incidents and create one single PSR (parent 
PSR) to aggregate all supplier's incidents. 

You can also set the result status of all related 
PSRs to change automatically when the 
aggregate PSR reaches a specific status. 

Product Line(s) Manually The product lines this PSR affects. 
 

Affected Items Tab of a PSR 
The Affected Items tab lists all the items that are affected by the current PSR. A single PSR can affect 
multiple items (parts, documents). An icon on the Affected Items tab indicates that it contains 
affected items. 
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Note You can add affected items only if the PSR has not reached the Released status of the 
workflow. 

You can edit any information that has changed since the PSR was created. You might also need to 
add additional items (like parts, documents, assemblies) that need resolution. The same applies to 
QCRs also. 

The Affected Items table has the following columns by default. 

Field Completed Conta ins . . .

Item Number Automatically, when created. Number of the affected item. 

Item Description Automatically, when created. Description of the item. 

Rev Found Manually The revision of the affected item in which the problem 
is found. For example, if the item has undergone five 
revisions, and this defect is identified in revision B, 
then the Rev Found field displays B. 

In Web Client, when you select an item to add, all 
revisions of the item appear in the drop-down list with 
the latest released revision shown by default. You 
can select to report on this current revision or an 
older revision of the item (for incidents associated 
with parts that are no longer used in latest models) or 
pending revisions of the item. 

Note: You can add multiple copies of an item at the 
same revision to the Affected Items tab. 

Affected Site Automatically, when created. The site at which the affected items are having 
problems. 

Failure Mode Manually Displays the way in which a product failed or did not 
meet customer requirements. You select the failure 
mode from a list defined by the Agile Administrator. 
Lists of failure modes can be defined for each 
subclass of an item. For example, a failure mode for 
a battery might be No Charge, and a failure mode for 
a power strip might be Blown Fuse. 

Quantity Affected Manually 
 

The number of items that were affected by the quality 
incident. 

Rev Fixed Automatically, when problem 
is fixed in the revision. It can 
also be changed manually. 

The revision of the item in which the problem is fixed. 
This field can be automatically populated when a 
related ECO is released, or it can be manually 
updated. 

Latest Change Automatically, when problem 
is fixed in the revision. 

The change number of the most recently released 
change, which is related to this PSRs affected items. 
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NCR Affected Items Attributes 
The attributes and operations of NCRs are similar to those of problem reports except for a few fields 
on the Affected Items tab, which are explained below. 

The following table lists fields that are used in addition to the fields used in problem reports. These 
fields provide additional information about deviations in one or more products. This is part of the 
process in which the quality assurance team examines incoming materials from a supplier 
shipment. 

Field  Completed  Conta ins . . .  

Conformance 
Specification

Manually Information about what the material should be, according to the 
engineering specifications. 

Serial/Lot Number Manually Serial number or lot number of the items. 

If there are problems, enter the serial or lot number of the batch 
that was defective (this is similar to the unique identifier for the 
batch of goods). 

Total Quantity  
Suspect

Manually Total quantity of items suspected of problems. 

If the shipment had problems based on the sample inspection, 
enter the total number of units that were suspected of having 
problems. 

For example, you receive a lot of 500 units and you inspect 20 
units and find that 5 are defective: 
y 500 total suspect 
y 20 checked 
y 5 affected 

Quantity Checked Manually The number of items that were checked. 

Quantity Affected Manually The actual number of items that had problems. 

Containment Actions Manually Containment actions taken to immediately dispose of the 
material. 

For example, scrap all materials, send back to supplier, mark the 
bad batches. 

RMA Number Manually Return merchandise authorization. This is the number from the 
supplier that authorizes you to send the defective materials back 
to the source; it is usually a slip of paper. 

Conforming Material  
Date

Manually The date when the supplier expects to be able to send materials 
that do conform to the specifications. 
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Editing Affected Items 
If you have the appropriate privileges, you can edit or remove items on the Affected Items tab. 

To edit an affected item in Java Client: 

1. Open a PSR, and click the Affected Items tab. 

2. Select the item row you want to edit, and click  Edit Affected Items. The Edit Affected Items 
dialog box appears. 

3. In the editable fields, enter text or use the lists to select values. 

4. When you are finished, click OK. 

For more information about the fields on this tab, see Affected Items Tab of a PSR (on page 
18). 

Note If you manually update the Rev Fixed field, then the Latest Change field is automatically 
populated with the ECO related to that revision change. The Rev Fixed drop-down list 
contains all revisions for the item. 

For example, you can manually update the Rev Fixed field in the following cases: 
y A quality incident is submitted, and a known fix has already been released or implemented. 

In this case, you simply update the Rev Fixed field to account for the fact that this problem 
was already addressed and corrected in that particular revision. 

y Update a PSR that does not have a parent and that is not associated with a change or 
QCR. 

To edit an affected item in Web Client: 

1. Open a PSR, and click the Affected Items tab. 

2. Select the item row you want to edit, and click the  Edit button. 

3. In the editable fields, enter text or use the lists to select values. 

4. When you are finished editing, click Save.  

For more information about the fields on this tab, see Affected Items Tab of a PSR (on page 
18). 

Note If you manually update the Rev Fixed field, then the Latest Change field is automatically 
populated with the ECO related to that revision change. The Rev Fixed list contains all 
revisions for the item. 

For example, you can manually update the Rev Fixed field in the following cases: 
y A quality incident is submitted, and a known fix has already been released or implemented. 

In this case, you simply update the Rev Fixed field to account for the fact that this problem 
was already addressed and corrected in that particular revision. 

y Update a PSR that does not have a parent and that is not associated with a change or 
QCR. 
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Adding Affected Items 
You can add items to the Affected Items tab of a PSR. 

To add affected items to a PSR in Java Client: 

1. Open the PSR, and click the Affected Items tab. 

2. Click the Add drop-down menu button and choose one of the following options:  

y   Create – Select a type from the Type list. If appropriate, enter an object number and a 
description. Click OK. 

y  Search – Search for one or more existing items.  

In the Add Affected Item dialog box, select a search method. To perform a simple search, enter 
the value to search for and click Search. You can also define an Advanced Search, run a Saved 
Search or a Parametric Search, select a Bookmark or Recently Visited Item (Shortcuts). If you 
want to select different revisions of items or edit other fields, make sure the Edit Rows After 
Adding box is checked. In the search results, select the items and click OK. All the items in the 
Selected Affected Items list are added to the Affected Items table. 

y  Type-in Known Number(s) – Enter one or more numbers on separate rows, and click 
Add. If you click the Add button once without selecting an option from the list, the Type-in 
Known Numbers dialog box appears. 

To add affected items to a PSR in Web Client: 

1. Open the PSR, and click the Affected Items tab. 

2. Click the Add menu button and choose one of the following options:  

y  Create New – Select a type from the Type list. If appropriate, enter an object number and 
a description. Click OK. 

y  Search – Search for one or more existing items.  

In the Add Affected Item dialog box, select a search method. To perform a simple search, enter 
the value to search for and click Search. You can also define an Advanced Search, run a Saved 
Search or a Parametric Search, select a Bookmark or Recently Visited Item (Shortcuts). If you 
want to select different revisions of items or edit other fields, make sure the Edit Rows After 
Adding box is checked. In the search results, select the items and click OK. All the items in the 
Selected Affected Items list are added to the Affected Items table. 

y  Type-in Known Number(s) – enter one or more numbers on separate rows, and click Add. 
If you click the Add button once without selecting an option from the list, the Type-in Known 
Numbers dialog box appears. 

Note An Agile PLM SmartRule named Many Items per PSR determines whether you can add 
multiple items to the Affected Items tab of a PSR. If Many Items per PSR is set to Allow, you 
can add more than one item to the PSR. Otherwise, you can add only one item (one row) 
to the PSR. 
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Removing Affected Items 
To remove affected items in Java Client: 

1. Open a PSR, and click the Affected Items tab. 

2. Click in one or more rows to select the items you want to delete. 

3. Click the Remove  button. 

The selected items are removed from the Affected Items tab after confirmation. 

To remove affected items in Web Client: 

1. Open a PSR you want to work with, and click the Affected Items tab. 

2. Select one or more rows for the items you want to delete. 

3. Click the  Remove button. 

The selected items are removed from the Affected Items tab after confirmation. 
 

Scenarios 
In the following scenarios the Rev Fixed and Latest Change fields are updated. 

Scenario 1

A problem report is filed on a defective assembly Revision C. A corrective action is initiated to 
investigate the defective assembly. A deviation is immediately created that specifies the 
replacement of the faulty component. In this case, the Latest Change field will be updated with the 
number of the deviation. 

After the root cause is identified, an engineering change order is created that will specify the 
permanent replacement of the defective component in the assembly, which will roll it to Revision D. 

In the problem report, the Rev Fixed field will display Rev D, and the Latest Change field will display 
the ECO number. 

Scenario 2

A problem report is filed on a critical device that is causing lots of failures in the field and is deemed 
unusable. An immediate stop ship is ordered that specifies the severity of the problem. In this case, 
the Latest Change field in the problem report is updated to the stop ship number. 

If at a later time a permanent change is implemented through an ECO, then the Rev Fixed and Latest 
Change fields are updated according to the details of the ECO. 

For standalone PSRs, the following cases are applied to update the Latest Change and Rev Fixed 
fields: 

à If PSRs are not aggregated into a QCR, you can manually update the Rev Fixed field, which will 
automatically fill in the Latest Change field. 

à If you manually overwrite the Rev Fixed field, but at a later time, a change is associated with this 
item, the Rev Fixed and Latest Change fields are still filled in automatically. 

à For example, the Rev Fixed field for an item is A, and the Latest Change field is ECO10. Then 
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another change is released, and the Latest Change field for the item is updated to ECO20. Now, 
if you manually select A in the Rev Fixed field, the Latest Change is automatically updated back to 

à  you specify a Rev Fixed date that is earlier than 

à lt of releasing the change, un-releasing the change encloses 
the Rev Fixed value in brackets. 

ECO10. 

Rev Fixed must always be later than Rev Found. If
the Rev Found date, an error message appears. 

If Rev Fixed is filled in as the resu

 

Related PSR Tab 
The Related PSR Tab contains a list of all PSRs that are aggregated into the current PSR. The 
current PSR is considered the Parent PSR. An icon on the Related PSR tab indicates that it 
contains related PSRs and QCRs. Once you have created a PSR, you can edit information about 

r 

 team creates 
 to the Parent PSR. 

The R  PSR table ha g columns by default. 

related PSRs. You can also aggregate related PSRs into this PSR (the Parent). 

For example, if multiple customers reported similar problems, a problem report would be created fo
each customer. The Quality team determines that these problems are related and can be solved 
with one solution.To provide a solution and resolve all the related PSRs, the Quality
one PSR (Parent) and adds (Aggregates) all the related PSRs

elated s the followin

Field  Completed  Conta ins . . .  

PSR Criteria Met he PSR Automatically, when t  
event criteria is met. 

 
. 

Once a 

Indicates when the PSR event occurred (that is, the parent
PSR has reached the status selected for the PSR event)

Once the parent PSR attains the status specified in the 
PSR Event field, then the related PSR status 
automatically moves to the status specified in the PSR 
Result field and completes the criteria specified. 
criterion is met, the symbol   is displayed. 

 PSR Event Manually  parent PSR that triggers an automated 

ed. 
ns that the PSR has 

set 
us in Java Client. For 

nd child) are assigned a workflow on 

The status of the
workflow event. 

Select an available status from the list. You can specify 
the status only when the PSR has a workflow assign
When this event occurs, it mea
reached the specified status. 

The default value of the PSR Event is set to the Closed 
status. If you have Quality Analyst privileges, you can 
the default value to another stat
details, see Relationships tab. 

Note: You can specify the PSR Event status only when 
both objects (parent a
the Cover Page tab. 
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Field  Completed  Conta ins . . .  

PSR Result Manually 

he list. You can specify the status only when the 

cified result status in this 

ality Analyst privileges, you can set 
r status in Java Client. For 

PSR Result status only when 
both objects (parent and child) are assigned a workflow on 

The status to which the related PSRs are promoted when 
the event status is reached. Select an available status 
from t
PSR has a workflow assigned. 

When the parent PSR reaches the status in the PSR 
Event field, then the status of the related PSR is 
automatically moved to the spe
field. 

The default value of the PSR Result is set to the Closed 
status. If you have Qu
the default value to anothe
details, see Relationships tab. 

Note: You can specify the 

the Cover Page tab. 

PSR Type Automatically The type of related PSR. 

PSR Number Manually, when a  
 added. related PSR  is

The related PSR number. 

PSR Category Automatically The quality incident category of the related PSR. 

PSR Description Automatically . Description of the related PSR

PSR Customer Automatically The customers associated with the related PSR. 

PSR Supplier Automatically The suppliers associated with the related PSR. 

PSR Severity Automatically The severity of the related PSR. Severities are defined by 
the Agile PLM administrator. 

PSR Disposition Automatically The way this PSR was resolved. 

PSR Expected  
Resolution Date

Automatically The related PSR expected problem resolution date. 

PSR Quality 
Analyst

Automatically The quality analyst assigned to the related PSR. 

If the workflow is defined to notify the default quality 
analyst, the department or user in this field receives 
notifications about the PSR. 

PSR Workflow Automatically The name of the workflow being used to move this PSR 
through the quality tracking process. 

PSR Status Automatically The related PSR workflow status. If no workflow has been 
selected, this field is Unassigned. 

PSR Originator hen created. The default creator of the PSR. Automatically, w

PSR Date  
Originated

Usually automatically,  
when created. 

The date the related PSR was created. 

PSR Date  
Submitted

Usually automatically,  
when created. 

The date the related PSR was submitted. 
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Field  Completed  Conta ins . . .  

PSR Date  
Released

Usually automatically,  
when created. 

The date the related PSR was released. 

PSR Final  
plete Date when created. 

The date the related PSR was completed. Usually automatically,  
Com

Aggregate PSR 
Number

Automatically filled i
when PSRs are add
to the Related PSR

n  
ed  
 tab. 

This field is automatically filled in with the parent PSR 
number.  

 
 

Editing Related PSRs 
If you have the appropriate privileges, you can edit and remove related PSRs. 

PSR tab. 

2. 

3. 

4. 

PSR Event ect 
tatu

the P
you s  to Closed, once the Parent PSR 
reaches the Closed status, the related (child) PSR moves automatically to the Closed status. 

lt fields display the Closed status, but you can 

To edit related PSRs in Java Client: 

1. Open a  and click the Related PSR

Select the PSR row you want to edit, and click the Edit button. 

In the editable fields, enter text or use the lists. 

When you are finished, click OK.  

The  drop-down list shows the available statuses of the Parent PSR. You can sel
s ses for the parent and the related PSR so that when the Parent PSR reaches the status in 

SR Event field, the related PSR moves to the status in the PSR Result field. For example, if 
et the PSR Event field to Closed and the PSR Result field

Note By default, the PSR Event and PSR Resu
select the required status from the list. The PSR Event and PSR Result lists are empty if no 
workflow is assigned for either Parent or child PSRs. 

To edit related PSRs in Web Client: 

1. 

2. 

3. 

PSR Event r 
he p  

Even
the P ed, once the Parent PSR reaches 
the Closed status, the related (child) PSR moves automatically to the Closed status. 

 Closed status, but you can 

Open a PSR and click the Related PSR tab. 

Select one or more PSR rows you want to edit, and click Edit. 
When you are finished, click OK. 

The  list shows the available statuses of the Parent PSR. You can select statuses fo
t arent and the related PSR so that when the Parent PSR reaches the status in the PSR

t field, the related PSR moves to the status in the PSR Result field. For example, if you set 
SR Event field to Closed and the PSR Result field to Clos

Note By default, the PSR Event and PSR Result fields display the
select the required status from the list. The 
workflow is assigned for either Pare

PSR Event and PSR Result lists are empty if no 
nt or child PSRs. 

 

Page - 26 Agile Product Lifecycle Management 

 

 



 Chapter 2  
 
 

Adding Related PSRs to the Parent PSR 
You can add related PSRs to a Parent PSR. 

After you add related PSRs to the Parent PSR, the Aggregate PSR
on the Related PSR tab displays the number of the Parent PSR. O

 Number column for each PSR 
n the Cover page of the child 

PSR

 To add related PSRs to the Parent PSR in Java Client: 

1. 

2. Clic

y 

s, th arent PSR number automatically fills in the Aggregate PSR Number field. e P

Open a PSR and click the Related PSR tab. 

k the Add menu and choose one of the following options: 

 Create – Select a type from the Type list. If appropriate, enter an object number. Click 
OK. 

y  Search – Search for one or more existing PSRs. In the Add Related PSRs dialog box, 

ark or a Recently Visited PSR (Shortcuts). If you want to edit fields after 
r Adding box is checked. In the search 
ll PSRs in the Selected Related PSR list are 

 Related PSR (Search) dialog box 

select a search method. If you choose to perform a simple search, enter the value to 
search for and click Search. You can also define an Advanced Search, run a Saved Search, 
select a Bookm
adding related PSRs, make sure the Edit Rows Afte
results, select the PSRs you want, and click OK. A
added to the Related PSR table. 

Note If you click the Add icon without selecting the list, the Add
is displayed. 

To add related PSRs to the parent PSR in Web Client: 

1. 

2. Clic

y 

Open a PSR and click the Related PSR tab. 

k the Add menu and choose one of the following options: 

 Create New – Select a type from the Type list. You can enter an Object number if 
applicable. Click OK. 

y  Search – Search for one or more existing PSRs. In the Add Related PSRs dialog box, 

Recently Visited PSR (Shortcuts). If you want to edit fields after 
Edit Rows After Adding box is checked. In the search 

t, and click OK. All PSRs in the Selected Related PSR list are 
 

lecting from the list, the Add Related PSR (Search) dialog 

select a search method. If you choose to perform a simple search, enter the value to 
search for and click Search. You can also define an Advanced Search, run a Saved Search, 
select a Bookmark or a 
adding related PSRs, make sure the 
results, select the PSRs you wan
added to the Related PSR table.

Note If you click the Add icon without se
box is displayed. 

 

R movin Related Pe SRs 

R you want to delete. 

g 
To remove a related PSR in Java Client: 

1. Open a PSR and click the Related PSR tab. 

2. Click in the row to select the related PS

3. Click the   Remove button. 
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The selected PSR is removed from the Related PSR tab after confirmation. The number of the Parent 
SR Number field on the Cover Page of the child PSR. 

ete. 

PSR is removed from Aggregate P

To remove a related PSR in Web Client: 

1. Open the PSR you want to work with, and click the Related PSR tab. 

2. Select the related PSR you want to del

3. Click the  Remove button. 

The selected PSR is removed from the Related PSR tab after confirmation. The number of the Parent 
PSR is removed from the Aggregate PSR Number field on the Cover Page of the child PSR. 
 

Relationships Tab 
The Relationships tab allows you to create relationships and dependencies between the current P

 other routable o
SR 

and bjects and lifecycle objects.  

erables on a project or task. 

able 
abled for 

 functionality exists for that class and its subclasses. 

à 

à hat the functionality will not be supported. 

In the Event/Result column: 

à Workflow - Indicates that the event/ result for that class object will be based on workflow states 
of that object. 

à Lifecycle - Indicates that the event/result for that class object will be based on Lifecycle states 
for that class. 

The Relationships tab:  

à Enables several objects to be added as deliv

à Enables relationships tab on several Agile objects to add, edit, and view relationships with 
projects/tasks. 

à Relationship objects have a rule associated with them. 
 

Relationships - Classes T
The following table lists all the Agile objects and also explains what needs to be en
relationships and references. 

à Exists - Indicates that the

In the Relationship with a Rule column: 

Yes - Indicates that the functionality will be added in its class and subclasses. 

No - Indicates t
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Agi le   
Base 
Class  

Agi le   
C lasses 

Event /  
Resul t  

Re lat ionship  
wi th  a  Rule  

References-
Relat ionship  
wi th  no  ru le  

L i fe  
cyc le  
under  

Change 
Control  

Changes Change  
Orders 

Workflow Exists Exists NA 

 Change  
Requests 

Workflow Exists Exists NA 

 Deviations Workflow Exists Exists NA 
 Manufacturers  

Orders 
Workflow Exists Exists NA 

 Price  
Change  
Orders 

Workflow Exists Exists NA 

 Site  
Change  
Orders 

Workflow Exists Exists NA 

 Stop Ship Workflow Exists Exists NA 

Customers Customers Lifecycle Yes Yes No 

Declarations Homogeneous 
Material 
Declaration 

Workflow Exists Exists NA 

 IPC 1752-1 
Declarations 

Workflow Exists Exists NA 

 IPC 1752-2 
Declarations 

Workflow Exists Exists NA 

 JGPSSI 
Declarations 

Workflow Exists Exists NA 

 Part Declarations Workflow Exists Exists NA 
 Substance 

Declarations 
Workflow Exists Exists NA 

 Supplier  
Declaration of 
Conformance 

Workflow Exists Exists NA 

File 
Folders

File Folders Lifecycle Exists Exists No 

Items Documents Lifecycle Yes Yes Yes 
 Parts Lifecycle Yes Yes Yes 

Manufacturer  
Parts

Manufacturer  
Parts 

Lifecycle Yes Yes No 
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Agi le   
Base 
Class  

Agi le   
C lasses 

Event /  
Resul t  

Re lat ionship  
wi th  a  Rule  

References- L i fe  
Relat ionship  cyc le  
wi th  no  ru le  under  

Change 
Control  

Manufacturer Manufacturer Lifecycle Yes Yes No 

Packages Packages Workflow Yes Yes NA 

Part  
Groups

Part Groups Lifecyce Yes Yes No 

Prices Published  
Process 

Lifecycle Yes Yes Yes 

 Quote Histories Lifecycle Yes Yes Yes 

PSRs Non- 
Conformance  
Reports 

Workflow Exists Exists NA 

 Problem  
Reports 

Workflow Exists Exists NA 

Programs Activities Workflow Exists Exists NA 
 Gates Workflow Exists Exists NA 

QCRs Audits Workflow Exists Exists NA 
 Corrective and 

Preventive Action 
Workflow Exists Exists NA 

Requests for 
Quotes

Requests for  
Quotes 

Lifecycle Yes Yes No 

RFQ  
responses

RFQ  
Responses 

Lifecycle Yes Yes No 

Sites Sites Lifecycle Yes Yes No 

Sourcing  
Projects

Sourcing  
Projects 

Lifecycle Yes Yes No 

Specifications Specifications Lifecycle Yes Yes No 

Substances Materials Lifecycle Yes Yes No 
 Sub Parts Lifecycle Yes Yes No 
 Substance  

Groups 
Lifecycle Yes Yes No 

Suppliers Suppliers Lifecycle Yes Yes No 

Transfer 
Orders

Automated  
Transfer  
Orders 

Workflow Yes Yes NA 

 Content  
Transfer  

Workflow Yes Yes NA 
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Agi le   
Base 
Class  

Agi le   
C lasses 

Event /  
Resul t  

Re lat ionship  
wi th  a  Rule  

References- L i fe  
Relat ionship  cyc le  
wi th  no  ru le  under  

Change 
Control  

Orders 

User  
Groups

User  
Groups 

None No Yes NA 

Users Users None No Yes NA 

Action 
Items

Action Items Status 
Attribute 

No No NA 

Discussions Discussions Status 
Attribute 

No Yes NA 

Reports Custom  
Reports 

None No No NA 

 External  
Reports 

None No No NA 

 Standard  
Reports 

None No No NA 

 
 

Attributes of the Relationships Tab 
à When an object is added to a project as a deliverable, the project gets added on the 

Relationship tab of that object. You can define a relationship rule between these two objects 
and the rule can be viewed from both objects. 

à When you add Object 1 as a relationship to Object 2, it creates a reverse relationship by which 
Object 2 will be displayed under the Relationship tab of Object 1. 

à You can add a PPM object under the Relationship tab of an object that is a deliverable. This 
will in turn display this object as a deliverable for the PPM object under the deliverable tab. 

à There are no default relationship rules between two objects. 

à When you add a relationship to an object that has a revision: 
The name field of parts or documents shows the object name or number only if the rule is 
pending. Click the object name or number. In the editable fields, enter text or use the lists. 

y 

y 
 

hown here. 
y 
� , edit or remove a rule, click the Add Rule, Edit Rule or Remove Rule 

�  Client, the rule is displayed in the table and you can edit it from the Preview 

The revision displays the latest revision. 
The object revision is displayed in the name field when the rule is met, (i.e. the lifecycle of 
the event has occurred). For example, if the triggering event is when the lifecycle is moved
to Production, then the first revision that resulted in production phase will be s
The name field value is hyperlinked and links to the cover page for revision. 

In Java Client, to add
button respectively.  
In Web
Pane. 
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y chments that are related to the folder version will be 

y  is sorted in an alphanumeric order and by the name 

The na ill be displayed as follows for th

When the criteria are met, the atta
displayed with the folder version. 
By default the Relationship table
attribute in an ascending order. 

me field w e following objects: 

Object  Name F ie ld  Display  

Item <Item Number>Rev:<Revision> 

Activity and Gate ty/Gate (Root Activity) Activi

 

Customer ustomer Name (Customer Number) C

 

Supplier Supplier Name (SupplierNumber) or Supplier Display Name 

Manufacturer Part Manufacturer Number (Manufacturer’s Name) 

File Folder File Name1.ext, File Name 2. ext, ..( display all files under the file folder)Ver: A 

 

The Relationships table has the following columns by default. 

Field  Completed . .  Conta ins . . .  

Criteria Met Icon
 

 

hip rule criteria 
 criterion is met, the Criteria Met symbol 

Automatically, when the
added object 
relations
is met. 

Indicates when the added object attains the status 
cified. Once aspe
 is displayed. 

Type (Image) Automatically The type of the added object. 

Name Automatically 

, sourcing projects, RFQs, 

The name/number of the added object. You can add 
items (parts, documents), changes, manufacturers, 
manufacturer parts, customers
suppliers, PE-related objects. 

Description Automatically The description of the added object. 

Current Status en The current status of the related object. Automatically, wh
object is added. 

Rule when 
rule is added. 

 
n objects are assigned a 

Automatically, Indicates the relationship rule applied to the object. Note:
You can specify Rule only whe
workflow on the Cover Page. 

Type Automatically The type of the added object. 

Relationship Type Automatically Indicates the relationship type. 
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Relationship Rules 
à You can define a rule only from a lifecycle object to a workflow object. 

When you add a relationship from a lifecycle object to a workflow object, the state of the lifecycle 
affects the state of the workflow object. 

For example, the relationship rule is defined from a Problem Service Request (workflow object) 
PR00061 to (workflow object) Engineering Change Order. The rule says that When the state of 
PR00061 is Released, Set the Engineering Change Order to Released. The positions of the “From 
Object” (PR00061) and the “To Object” (Engineering Change Order) are fixed in the rule so that the 
rule only impacts workflow objects. 

When you add a relationship from a workflow object to a lifecycle object, the state of the lifecycle 
objects affects the state of the workflow object and not the reverse way. 

à When you add a relationship from a workflow object, you can define a relationship rule to another workflow 
object in both directions. 

For example, in a relationship between two workflow objects – QCR QCR12345 and PSR PR55768 
the When drop-down will list two objects – QCR12345 and PR55768, the Set drop-down will also 
have the same two objects. You cannot select the same object in both, When and Set. When you 
select an object from When list the Set field will be upgraded with another object.  

The relationship should be viewable from both the objects and the rule displayed must be the same. 

à You cannot define a relationship rule between two lifecycle objects. 

A relationship rule can only be defined between a lifecycle object and a workflow object and not 
between two lifecycle objects. 
 

Adding Objects to the Relationships Table 
To add objects to the Relationships table in Java Client: 

1. Open the PSR, and click the Relationships tab. 

2. Click the Add  menu and choose one of the following options: 
y Create – Select a type from the Type list. You can also enter an an object number if 

applicable. 
y Search ne or more existing objects.  – Search for o

In the Add Relationship dialog box, select a search method. If you choose to perform a simple 
search, enter the value to search for and click Search. 

You can also define an advanced search, run a saved search, select a bookmark or recently 
visited objects (Shortcuts). If you want to edit fields after adding related objects, ensure that the 
Edit rows after adding option is checked. 

3. In the search results, select the objects. 

4. Click OK. 

The objects in the Selected Related Objects list are added to the Relationships table. 

Note When you add an object to the Relationships table of a PSR, the PSR is added on the 
Relationships tab of the object. 
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To add objects to the Relationships table in Web Client: 

1. Open the PSR, and click the Relationships tab. 

2. Select the Add  menu and choose one of the following options: 
y Create New – Displays a dialog box from which you can select a value or object from the 

Type drop-down list. You can also enter an object number if applicable. 
y Search – Displays the Search dialog box from which you can search for one or more 

existing objects. 

In the Add Relationships dialog box select a search method. If you choose to perform a simple 
search, enter the value to search for and click Search.  

You can also define a parametric search, an advanced search, run a saved search, select a 
bookmark or recently visited objects (Shortcuts). If you want to edit fields after adding related 
objects, ensure that the Edit Rows After Adding option is checked.  

3. In the search results, select the objects and click Add Selections. 

4. Click OK. 

The selected objects are added to the Relationships table. 

Note When you add an object to the Relationships table of a PSR, the PSR is added on the 
Relationships tab of the object. 

 

Editing and Removing Objects in the Relationships Table 
After you have created a problem report or non-conformance report, you can edit the report to 
provide additional information you did not include when you created it. You can also edit any 
information that has changed since the PSR was created. 

To edit objects in the Relationships table: 

1. Open the PSR, and click the Relationships tab. 

2. Select the object you want to edit. 

3. Click the Edit Relationship icon and edit the appropriate fields. 

4. Click Save. 

The Cover Page displays the edited version of the object. 

To remove objects in the Relationships table: 

1. Open the PSR, and click the Relationships tab.  

2. Select the object you want to remove. 

3. Click Remove Relationship. 

The selected object is removed after confirmation. 
 

Filter 
Filters narrow down the objects in the relationship tab of PSRs by the rule they contain. You can 
filter relationships with the attributes you configure using the View Filter option. The default View 
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Filter options consists of 4 values: 

à All Relationships 

This filter allows you to filter all the relationship objects in the table. 

à Complete 

This filter allows you to filter all the objects for which the rule criteria are met. 

à Pending 

This filter allows you to filter objects for which the rule criteria are not met. 

à Rule not specified 

This filter allows you to filter objects for which there are no rules specified. 

To filter relationships further, additional filter attributes are provided.  

Click Show Filter  icon, and you can filter by the following attributes: 
y Criteria Met - Filters relationships where criteria is met. 
y Name - Filters relationships by names. 
y Description - Filters relationships by the description. 

You can lowing conditions: 

 not met. 
ference rows). 

, then returns all relationship rows. 

 an object, details about the relationship will 

view pane also displays the attributes and actions that can be performed on the relationship 

e 
 the 

such as attachments, etc., of that revision.   

review Pane. A Relationship Rule window appears.  

2. 

ne. 

y Rule - Filters relationships by rules. 
y Type - Filters relationships by the types. 

 further filter on the Criteria Met attribute using the fol
� If Yes, then returns rows where it is checked. 
� If No, then returns only relationship rows for which criteria are
� If Null, then returns only rows with no rules (re
� If Not Null

 

Preview Pane 
In the Relationships table, when you add a relationship to
be displayed in the lower pane called the Preview Pane. 

The pre
object. 

The name field is a hyperlink which displays information about the object on the preview pane. Th
revision field displays a drop-down which lists all the revisions of the object. You can choose
revision and the preview pane displays details 

You can add a Rule to the Relationship. 

1. Click on the Add Rule link in the P

Specify the rule and click Save.  
y Click on the Edit rule link to edit the rule.  
y Click on the Remove rule link to remove the rule. 

Actions like Add, Remove, and View can also be performed on the object from the preview pa
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Thus you can add attachments, content, affected items, prices, and create changes to the 

à 

à Add By search - Search for existing files. To perform a simple search, enter the value and click 
rch, run a saved search or select a recently visited 
earch Attachment Contents. 

e PLM 
le object follows as it goes through the different 

 

r for 
n to identify if it merits a corrective action. It can also be routed to the support call center or 

nted fix or to a supplier for a response to the incident, and so on. 

same way as for other routable objects. 

Relationship object on the preview pane. 

You can also: 

à Add files  - By file name and description. 

Add URLs  - By name and description (Internet Address). 

Search. You can also define an advanced sea
item (shortcuts). You can also search in the S

 

Workflow Tab of a PSR 
The Workflow tab displays a flowchart of the workflow you selected on the cover page. An Agil
workflow is a sequence of statuses that a routab
statuses in the quality control process. The status with the orange background (Web-Client) or
yellow background (Java-Client) is the current status. The Signoff History table displays past 
workflow and sign-off information for the PSR. 

For example, a PSR can be routed internally for preliminary investigation, or to a manage
escalatio
the field service technician, who can provide more detailed information or to the customer for final 
approval of an impleme

Note Workflows for product service requests work the 
 

Attachments Tab of a PSR 
You can reference files and URLs from the Attachments tab of Agile PLM objects. Such files and
URLs are gene

 
rally referred to as attachments, or more formally as attachment files. Attachment files 

 file vault). 
le, if a 

 files: 

 also check in and check out 
cts in and out). 

and URLs can be tracked and searched, when you attach a file to an object. It is also added to an 
automatically created object called a file folder - an object of reference information from the File 
Folders class. 

The actual attachment files are stored in the Agile File Manager (also referred to as the
Attachments may contain information that describes the object or a process. For examp
specification describes a part or subassembly, it might have the following attachment

à Drawing files (such as CAD drawings) or scanned image files in viewable formats 

à Files such as documents, non-viewable files, compressed (ZIP) files, and so on 

You can view, copy, delete, and print attachment files. You can
attachments (although you are actually checking file folder obje
 

Submitting and Routing PSRs 
You can submit and route PSRs using the Next Status button. The process is the same as for 
submitting and routing other routable objects. Before switching the PSR to a different status, always 
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audit it to detect any errors that may prevent switching to a different status. 

For more information about the default workflows for PSRs, see the Agile PLM Administrator Guide. 

hen you submit a PSR, the Quality Analyst is notified by email. The Quality Analyst can also use 
the searches in Workflow Routings area of the Home Page or Quality Searches folder to find 
recently submitted PSRs. 
 

W
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Working with Quality Change Requests 
This chapter includes the following: 

� Creating QCRs .................................................................................................................................................... 39 
� Cover Page Tab of a QCR................................................................................................................................... 43 
� Affected Items Tab of a QCR............................................................................................................................... 45 
� Relationships Tab of a QCR................................................................................................................................ 46 
� Workflow Tab of a QCR....................................................................................................................................... 46 
� Attachments Tab of QCR..................................................................................................................................... 46 
� Submitting and Routing QCRs............................................................................................................................. 46 

 
 

Creating QCRs 
You must have the necessary privileges to create a QCR object. A QCR object is created the same 
way other Agile PLM objects are created. You can use the New Object button or the Save As feature. 

To create a QCR in Java Client: 

1. Click the New Object button . The New Object dialog box appears. 

2. In the Type list, select Audit or CAPA. 

3. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button  to automatically enter the next number. 

4. Click OK. 

Agile Java Client creates the QCR object and displays the QCR (audit or CAPA) with the Cover 
Page tab on top. 

To create a QCR in Web Client: 

1. From the main toolbar, choose Create,  select Quality Change Request and then select Audit or 
Corrective and Preventive Actions. The Create Quality Change Request wizard appears. 

2. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button   to automatically enter the next number.  

3. Click Next. The Enter Cover Page Information page appears. 

4. Enter the required information. You can assign a workflow to route the QCR through the 
workflow statuses.  

5. Click Next. The Add Affected Items page appears. 

6. Click the Add button to add one or more items. The Add Affected Items Wizard appears. For 
more details, see Adding Affected Items (on page 22). 

7. Click Next to add attachments. The Add Attachments page appears. 
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8. Click the Add button to add attachments if necessary. The Add Attachments Wizard appears. 
For more details, see Attachments Tab of a PSR (on page 36).  

9. Click Finish. 

Agile Web Client creates the QCR and displays it with the Cover Page tab on top. If a workflow is 
not assigned to the QCR, the status is Unassigned. To assign a workflow, click the Edit button 
on the Cover Page and select a workflow from the Workflow list. 

Notice that the Default Audits and Default CAPAs workflow statuses are different from those for 
other routable objects. The audit workflow starts with Prepared and the CAPA workflow starts 
with Identified. 

Note The audit reminder will be sent to originator and quality administrator before the audit 
date. If you have Modify privileges, you can configure the audit reminder date in the 
\\agile_home\agileDomain\config\agile.properties file. Edit the value of the parameter 
pcm.notification.audit.reminder.backwarn.period=168.  
The default value is 168 hours (equal to 7 days). 

 

Creating a QCR Using Save As 
You can use Save As to create a QCR.  Save As copies data from a field in the existing object to the 
same field in the new object. If a field or list value in the existing object is not available in the new 
object, then that field or list value is not copied to the new object. 

To create a QCR using Save As in Java Client: 

1. Open the QCR you want to use as the basis for the new QCR. Right-click, and choose Save As. 
Or choose File and select Save As from the main toolbar. The New Object dialog box appears. 

2. From the Type list, select Audit or CAPA. 

3. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button  to automatically enter the next number. 

4. Click OK. 

Agile Java Client creates the QCR (audit or CAPA) and displays the QCR with the Cover Page 
tab on top. 

5. Make appropriate modifications on the tabs.  

6. Click Save. 

To create a QCR using Save As in Web Client:   

1. Open the QCR you want to use as the basis for the new QCR. Choose Actions and select Save 
As. 

2. Select Audit or CAPA from the Subclass list. 

3. In the Number field, accept the number that appears. You can also type a number or click the 
AutoNumber button  to automatically enter the next number. 

4. Click Save. The new object opens. 

5. Click the Edit button to make appropriate modifications to the tabs. 

6. Click Save. 

Page - 40 Agile Product Lifecycle Management 

 

 



 Chapter 3  
 
 

Note If the Agile PLM Administrator has set the appropriate preferences, fields in the optional 
Page Two and Page Three sections are copied to the new object. For information about the 
behavior of Page Two and Page Three fields in your Agile PLM system, see your Agile 
PLM Administrator. Since Page Three data applies to a specific subclass only, if you use 
Save As to create a new object of a different subclass, the Page Three data is not copied to 
the new object. 

 

Completing and Editing a QCR 
After a QCR is created, you can edit the report to provide additional information you did not include 
when you created it. You can also edit any information that has changed since the QCR was 
created. 

Complete the appropriate fields on the Cover Page tab. for details, see Cover Page Tab of a QCR (on 
page 43).  

1. Click the Affected Items tab. You can add, edit, or remove affected items using the Add, Edit, and 
Remove buttons. In the editable fields, enter text or use the drop-down lists. Adding, editing, and 
removing item is the same as for PSRs. For more details, see Affected Items Tab of a PSR (on 
page 18). 

In the PSR Items table, the items associated with PSRs are listed. If you add PSRs to the 
Relationships tab, all items of those PSRs are automatically added to the PSR Items table. If you 
are auditing or taking corrective action on items listed in the PSR, when the fix is checked and 
verified, the QCR can move to the Validate and then the Closed status. 

2. To route the QCR through the workflow statuses, click the Workflow tab. If you assigned a 
workflow when you created the QCR, the assigned workflow chart appears on this tab. If it is 
not displayed, you can assign it by selecting a workflow on the Cover Page. 

Click the Next Status button or the required status to change the status of workflow in the 
workflow chart. When you change the status, you specify approvers and observers to be 
notified. 

3. Click the Relationships tab. 

Add relationships or edit any of the existing relationships listed. For more details, see 
Relationships tab. 

4. Click the Attachments tab. 

Add attachments as needed, or edit any of the existing attachments listed. 

If you have the appropriate privileges, you can edit a QCR. You cannot edit closed QCRs unless 
you have the specific privilege to do so. 

To edit a QCR: 

1.  Open the QCR you want to edit. 

2.  In the editable fields, enter text or use the drop-down lists. 

3.  When you are finished, click Save. 

The QCR displays the Cover Page with the latest edition. 
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Creating a QCR from a PSR or an Item 
You can create a QCR directly from a PSR or an individual item. The QCR allows you to aggregate 
incoming problems into a routable quality record, perform root-cause failure analysis, and drive the 
problems to closure using standard CAPA (corrective and preventive actions) procedures. 

When you create a QCR from a PSR, the following information is copied: 

à The PSR is added to the Relationships tab of the QCR. 

à The QCR is added to the Relationships table of the PSR. 

à All information on the Affected Items tab of the PSR is added to the PSR Items table on the 
Affected Items tab of the QCR.  

à An icon  is displayed in the QCR Affected Items tab to indicate that it contains a PSR item. 

You can set the event trigger to move the PSR to a specific status in the workflow when the QCR 
event occurs. 

When you create a QCR from an item to drive a problem to closure, the following information is 
copied: 

à The item is added to the Affected Items tab of the QCR. 

à The QCR is added to the QCRs table on the Quality tab of the item. 

After the QCR is approved, you can route the item through the change to make sure that the defect 
is rectified and changed to new revision of the item. 

To create a QCR from a PSR or an item in Java Client: 

1. Open the PSR or item from which you want to create a QCR. Right-click in the object window, 
Create Quality Change Request from the shortcut menu. and choose 

2. Select Audit or CAPA from the  list. 

3. In the 

Type
Number field, accept the number that appears. You can also type a number or click the 

AutoN ber button  to automatically enter the next number. um
4. Click OK.  

Agile Java Client creates the QCR. 

To create a QCR from a PSR or an item in Web Client: 

1. Open the PSR or item from which you want to create a QCR. Choose Actions > Quality Change 
Request. The Quality Change Request Wizard appears. 

2. Select Audit or Corrective and Preventive Actions from the  list. 

3. In the 

Subclass
Number field, accept the number that appears. You can also type a number or click the 

AutoN  to automatically enter the next number.  umber button 

4. Click Finish.  

Agile Web Client creates the QCR. 
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Cover Page Tab of a QCR 
The following table lists and describes the fields on the QCR Cover Page tab. 

Field  Completed  Conta ins . . .  

QCR Number Automatically, when created. The number assigned to the QCR when you create it. 

QCR Type Automatically, when created. The type (subclass) selected when you create the QCR. 

Category Manually The list of categories defined by the Agile PLM 
administrator, for example:  

Customer Complaint 
Audit - External 
Preventive Action 

Description Usually manually; can contain a 
default. 

The maximum number of bytes is set by the Agile PLM 
administrator; can be up to 4000 bytes, including 
spaces and carriage returns (which count as two bytes). 

Reason Usually manually; can contain a 
default. 

Reason for creating this QCR. Maximum number of 
bytes is set by the Agile PLM administrator; can be up 
to 4000 bytes, including spaces and carriage returns 
(which count as two bytes). 

Customer Manually The customer associated with this QCR. 

Supplier Manually The list of suppliers. 

For example, you can initiate a QCR for suppliers to 
audit them or to generate a SCAR (supplier corrective 
action request) if the supplier has problems with its 
process, products, or other areas, and they need to be 
resolved. 

Workflow If more than one workflow 
applies to the QCR, the 
workflow is selected manually; 
the workflow selection can be 
changed as long as the QCR is 
in the Pending status type. 
Selecting the blank field in the 
workflow list switches the QCR 
to the Unassigned status. 
If no workflow is assigned, and 
you move the QCR to the next 
status from the Unassigned 
status, you are prompted to 
select a workflow 

The name of the workflow used to move this QCR 
through the quality control process. 
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Field  Completed  Conta ins . . .  

Quality  
Administrator

Selected manually from a list. 
Departments appear first in the 
list, followed by individual user 
names. 

The default quality administrator. 
If the workflow is defined to notify the default quality 
administrator, the user groups or user in this field 
receives notifications about the QCR. If this field is left 
blank, then the notifications are sent to every quality 
administrator on the list. If the notification definition in 
the workflow is blank, no notifications are sent. 

Status Automatically, when created; 
updated as the QCR moves 
through the assigned workflow. 

Workflow status. If no workflow has been selected, this 
field is Unassigned. 

Originator Usually automatically, when 
created (with the default set by 
the Agile PLM administrator). 

The originator or quality administrator who created the 
QCR. 

Date Originated Usually automatically, when 
created. 

The date the QCR was created. 

Date Submitted Automatically generated based 
on workflow status. 

The date when the QCR moves to the Submitted status 
in the workflow. 

Date Released Automatically generated based 
on workflow status. 

The date when the QCR moves to the first Released 
status in the workflow. 

Final  
Complete Date

Automatically, when the QCR 
enters the Complete type status. 

The date the QCR moved into the Complete status 
type. 

Preventive  
Action

Usually manually; can contain a 
default. 

Maximum number of bytes is set 
by the Agile PLM administrator; 
can be up to 4000 bytes, 
including spaces and carriage 
returns (which count as two 
bytes). 

A proactive action to prevent the problem from 
happening again in the future. This applies only to 
CAPAs. 

Root  
Cause  
Analysis

Manually. 

Maximum number of bytes is set 
by the Agile PLM administrator; 
can be up to 4000 bytes, 
including spaces and carriage 
returns (which count as two 
bytes). 

The root cause of the problem. 

For example, when there is a problem, engineers 
analyze why the problem occurred, all the way to the 
origin (root) of the problem. The information about their 
methods can be entered in this field. This applies only 
to CAPAs. 

Planned  
Audit Date

Manually Date planned to audit the problem. 
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Field  Completed  Conta ins . . .  

Audit Result Usually manually; can contain a 
default. 

For example, when a corrective 
action is implemented, the 
quality analyst performs audits 
to make sure the corrective 
action really solved the problem. 
If the fix for the problem is 
validated, then the audit result is 
pass. Otherwise, the audit fails, 
and the quality analyst updates 
Audit Result field. 

Audit process result. The default setting for audit result 
is Pass/Fail. Your administrator can define lists of other 
audit results. For more details, check with your 
administrator. 

Incoming problem is audited and the result is specified. 

Product  
Line(s)

Usually manually; can contain a 
default. 

List of product lines defined by the Agile PLM 
administrator. 

 
 

Affected Items Tab of a QCR 
The Affected Items Tab of a QCR includes the Affected Items tables and PSR Items tables. 

The Affected Items table lists the items that are affected by the QCR. If you have the appropriate 
privileges, you can modify this table and add items that are affected by this QCR. An icon  
displayed in the Affected Items tab of a QCR indicates that it contains a PSR item.  

Field Completed Conta ins . . .

Item Number Automatically, when created. Number of the affected item. 

Item Description Automatically, when created. Description of the item. 

Item Rev Manually The revision of the affected item in which the problem is 
found. For example, if the item has undergone five 
revisions, and this defect is identified in revision B, then 
the Item Rev field displays B. 

Note: You can add multiple copies of an item with the 
same revision number to the Affected Items tab of a 
QCR. 

Affected Site Automatically, when created. The site at which the affected items are having 
problems. 

 

The PSR Items table lists the items that are referenced by problem reports and non-conformance 
reports associated with this QCR. This table is filled in automatically when the Relationship Rule 
has the QCR affect the PSR. 

à Associate a PSR with the QCR by adding the PSR to the QCR Relationships tab and adding a 
Rule where the QCR affects the PSR. 

à Associate a PSR with the QCR by adding the QCR to the PSR Relationships tab and adding a 
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Rule where the QCR affects the PSR. 

à Create a QCR from a PSR. 

Field Completed Conta ins . . .

Item Number Automatically, when created. Number of the affected item. 

Item Description Automatically, when created. Description of the item. 

Item Rev Manually The revision of the affected item in which the problem 
is found.  

Affected Site Automatically, when created. The site at which the affected items are having 
problems. 

PSR Number Automatically, when created. The number of the PSR associated with this QCR. 

Relationships Tab of a QCR 
The Relationships tab allows you to create relationships and dependencies between the current QCR 
and other routable and lifecycle objects.  

The Relationships tab of a QCR is similar to that of a PSR. For details, see Relationships tab.
 

Workflow Tab of a QCR 
The Workflow tab displays a flowchart of the workflow you selected on the Cover Page. An Agile 
PLM workflow is a sequence of statuses that a routable object follows as it goes through the 
different statuses in quality control process. The status with the orange background (Web Client) or 
the yellow background (Java Client) is the current status. The Signoff History table displays past 
workflow and signoff information for the QCR. 

For example, a QCR can be routed to a manager for escalation to identify if corrective action should 
be taken. It can also be routed to the support call center or the field service technician, who can 
provide more detailed information, to the customer for final approval of an implemented fix, to a 
supplier for a response to the incident, and so on. 
 

Attachments Tab of QCR 
You can reference files and URLs from the Attachments tab of Agile PLM objects of a QCR. The 
Attachments Tab of the QCR is similar to that of a PSR. For details, see Attachments Tab of a PSR 
(on page 36). 
 

Submitting and Routing QCRs 
You can submit QCRs using the Next Status button. The process is the same as for submitting other 
routable objects. Before switching the QCR to a different status, always audit the routable object to 
detect any errors that may prevent switching to a different status. 

When you submit a QCR, the Quality Administrator is notified by email. The Quality Administrator 
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can also use the defined searches in the Workflow Routings area of the Inbox or the Quality Searches 
lder to find recently submitted QCRs. 

 
fo
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Managing PSRs 
This chapter includes the following: 

� Approving, Rejecting, and Commenting on PSRs ............................................................................................... 49 
� Releasing a PSR ................................................................................................................................................. 49 
� Deleting a PSR .................................................................................................................................................... 49 
� Undeleting a PSR ................................................................................................................................................ 51 
� Closing a PSR ..................................................................................................................................................... 51 
� Actions Menu in a PSR........................................................................................................................................ 51 

 
 

Approving, Rejecting, and Commenting on PSRs 
When a PSR is in a Review type or Released type status, you can approve, reject, or comment on 
the PSR by clicking the appropriate button in the toolbar. For details, see the Getting Started Guide. 

Note Comments can be added to a PSR in any status except the Closed status. 
 

Releasing a PSR 
You can release PSR by using the Next Status button or the Workflow tab. If the AutoPromote 
property of the preceding Review status type is set to Yes, the routable object is automatically 
released when all the approvers have approved the change. 

Before a PSR can be released, it needs to be audited and pass the audit release. The system will 
check the following audit for each status level: 

For status types Pending, Review, Released, and Complete:
y Required fields for the current status level will be checked. (Your Agile Administrator 

determines which fields are required in the workflow property settings.) 

For status type Review: 
y Approval of all approvers will be checked. 

For status type Released: 
y All current release audit rules will be checked. 

For detailed steps to release PSR, see chapter Routing Objects with Workflows in the Getting 
Started Guide. 
 

Deleting a PSR 
Agile Java Client supports soft and hard deletes. To permanently delete an object from the Agile 
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database, you must first soft-delete it, then hard-delete it. For more information about soft-deleted 
and hard-deleted objects, see the Getting Started Guide. 

You cannot delete a PSR if: 
y It exists in a QCR’s Relationships tab (cannot delete if PSR is currently part of a corrective 

action process; you can remove the PSR from the QCR and then delete the PSR).  
y It exists in the Related PSR tab of another PSR (cannot delete if PSR is currently part of a 

larger problem; you can remove this PSR from the parent PSR and then delete it). 
y It exists in the Related PSR tab (cannot delete if PSR is being used to aggregate multiple 

problems; you can remove the related PSRs and then delete it). 
y It is in any state other than Pending or Unassigned (therefore, it can be deleted in Pending or 

Unassigned states). 

To soft-delete a PSR in Java Client: 

1. Select and open a PSR. 

2. Click the Delete button in the toolbar.  

Or choose Edit | Delete from the menu bar. 

Or right-click in the PSR window and choose Delete from the shortcut menu. 

The PSR is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its 
number is reserved in the Agile database and cannot be reused. 

To soft-delete a PSR in Web Client: 

1. Select and open a PSR. 

2. Click the Actions | Delete. 

The PSR is soft-deleted. It is no longer available for use. However, until it is hard-deleted, its 
number is reserved in theAgile database and cannot be reused. 

To hard-delete a soft-deleted PSR in Java Client (if you have the appropriate privileges): 

1. Find the soft-deleted PSR you want to hard-delete. 

From the Recycle Bin Searches folder, select the Deleted Product Service Requests to locate the soft-
deleted PSR you want to hard-delete. 

2. Select and open the soft-deleted PSR you want to hard-delete. 

3. Click the Delete button in the toolbar.  

Or choose Edit | Delete from the menu bar. 

Or right-click in the PSR window and choose Delete from the shortcut menu. 

The PSR is now hard-deleted from the database. 

Note Hard-deleting an object releases its number to be reused if needed. 

To hard-delete a soft-deleted PSR in Web Client (if you have the appropriate privileges): 

1. Find the soft-deleted PSR you want to hard-delete. 

From the Recycle Bin Searches folder, select the Deleted Product Service Requests to locate the soft-
deleted PSR you want to hard-delete. 
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2. Select and open the soft-deleted PSR you want to hard-delete. 

3. 

Note Hard-deleting an object releases its number to be reused if needed. 

Click the Actions | Delete. 

The PSR is now hard-deleted from the database. 

 

Undeleting a PSR 
cts still exist in the database, you can undelete them, if you have the 

ppropriate privileges): 

1. 

 select the Deleted Product Service Requests to locate the soft-

ant to undelete. 

Since soft-deleted obje
necessary privileges. 

To undelete a PSR in Java Client (if you have the a

Find the soft-deleted PSR you want to undelete. 

From the Recycle Bin Searches folder,
deleted PSR you want to undelete. 

2. Select and open the soft-deleted PSR you w

3. Click the Undelete  button in the toolbar.  

4. choose Undelete from the shortcut menu.  

ppropriate privileges): 

1. 

 select the Deleted Quality Change Requests to locate the soft-

-deleted PSR you want to undelete. 

3. 

The PSR is now undeleted from the database. 

Closing a PSR 
owing ways: 

Closing is handled by setting the Rule on Relationships tab of the PSR so that PSR result is 

erform on the PSR such as: 

 changes in the objects. Needs 

You can also right-click in the PSR window and 

The PSR is now undeleted from the database. 

To undelete a PSR in Web Client (if you have the a

Find the soft-deleted PSR you want to undelete. 

From the Recycle Bin Searches folder,
deleted PSR you want to undelete. 

2. Select and open the soft

Click Actions | Undelete.  

 

PSRs can be closed (promoted to their Complete status) in the foll

à Users with appropriate privileges can manually close a PSR. 

à 
closed. 

 

Actions Menu in a PSR 
The Actions menu provides you with a list of actions that you can p

à Bookmark: Saves the PSR as a Bookmark for future retrieval. 

à Subscribe: Subscriptions enable you to notify Originator of the
necessary privileges. 
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à Save As: Saves the PSR with all editions for future retrieval. 

s you to the location you were in by copying the URL to the 

 

à 

 Create Quality Change Requests: Allows you to create a quality change request on the PSR. 

à View Workflows: Allows you to view the current state the workflow of the PSR is in. 
 

à Delete: Deletes the PSR. 

à Copy URL to Clipboard: Take
Clipboard. 

à Print: Prints the PSR. 

à Export: Exports the PSR to a delimited text file(CSV) or to Microsoft Excel Notebook.

Send: Sends the PSR to other Users who have the necessary Roles and Privileges. à 

Sharing: Enables other Users to share the object. Needs necessary privileges.  

à
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� Releasing a QCR................................................................................................................................................. 54 
� Deleting a QCR.................................................................................................................................................... 54 
� Undeleting a QCR................................................................................................................................................ 56 
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� Actions Menu in a QCR ....................................................................................................................................... 56 

 
 

Approving, Rejecting, and Commenting on 
QCRs 
When a QCR is in a Review or Released type status, you can approve, reject, or comment on the 
QCR by clicking the appropriate button in the toolbar. For details, see the Getting Started Guide. 
 

Approving a QCR 
If you are specified as an Approver on a QCR, then you have to verify if the audit or corrective 
action has been implemented and tested for a specific item. 

To approve a QCR: 

1. Open the QCR you want to approve. Click the Approve button. The Approve wizard appears. 

2. In the Comments field, enter approver comments. 

3. In the Password field, enter your password. 

4. If you want to approve on behalf of your group, click Approving for Groups. 

You can also notify users that you have approved the QCR. 

5. Select the users you want to notify and click Notify. 

6. Click the Approve button. 

Note Comments can be added to a QCR in any status except the Closed status. 
 

Commenting on a QCR 
If you hold appropriate privileges, you can comment on QCRs and notify the comment to 
Originators, Reviewers and even Users. 
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To comment on a QCR: 

1. Open the QCR. 

2. Click the Comment button on the Cover Page. The Comment dialog opens. 

3. In the Comments field, enter your comments. 

4. To notify the Originator, Quality Administrator and Reviewers about your comments, select the 
respective check boxes. 

You can also notify certain users about your comments on the QCR.  

5. Select the users you want to notify and click Notify. 

6. Click the Comment button. 
 

Rejecting a QCR 
You can reject QCRs if they are not appropriate. You need to hold the necessary privileges to reject 
a QCR. For example, if you are a Quality Manager and you feel the corrective action taken by your 
team is not appropriate, you can reject the action. 

To reject a QCR: 

1. Open the QCR you want to reject.  

2. Click the  Reject button. The Reject wizard appears. 

3. In the Comments field, enter Approver comments.  

4. In the Password field, enter your password. 

You can also notify users that you have rejected the QCR. 

5. Select the users you want to notify and click Notify. 

6. Click the Reject button. 
 

Releasing a QCR 
Click Actions > Audit Release to release a QCR. 

 The following are checked for the audit release of a QCR: 
y If the QCR displays a warning when there exists an unreleased Change in the Relationships 

tab. This ensures that the Change is released and verified before releasing the QCR, not 
just ECO. 

y If the QCR displays a warning when an item in the QCR Affected Items or PSR Items does 
not exist on the Affected Items list of the Change. This ensures that all the items from the 
QCR are accounted for in one or more related Change. 

 

Deleting a QCR 
Agile Java Client supports soft and hard deletes. To permanently delete an object from the Agile 
database, you must first soft-delete it, then hard-delete it. For more information about soft-deleted 
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and hard-deleted objects, see the Getting Started Guide. 

You can delete a QCR that meets the following conditions: 

à You cannot delete a QCR if it has even one PSR in the Relationships tab. You cannot delete a 
QCR  if the corrective action process contains problems.  
You have to remove the PSR from the QCR and then delete the QCR. 

à You cannot delete a QCR if it has even one Change in the Relationships tab. You cannot delete 
a QCR if the corrective action process is already routed through engineering changes. You 
have to remove the Changes from the QCR and then delete the QCR. 

à You cannot delete a QCR if it is in any state other than Pending or Unassigned (therefore, it can 
be deleted in Pending or Unassigned states). 

To soft-delete a QCR in Java Client: 

1. Select and open a QCR. 

2. Click the Delete button in the toolbar.  

Or right-click in the QCR window and choose Delete from the shortcut menu. 

The QCR is soft-deleted. It is no longer available for use. However, until it is hard-deleted, it's 
number is reserved in the Agile database and cannot be reused. 

To soft-delete a QCR in Web Client: 

1. Select and open a QCR. 

2. Click the Actions | Delete. 

The QCR is soft-deleted. It is no longer available for use. However, until it is hard-deleted, it's 
number is reserved in the Agile database and cannot be reused. 

To hard-delete a soft-deleted QCR in Java Client (if you have the appropriate privileges): 

1. Find the soft-deleted QCR you want to hard-delete. 

From the Recycle Bin Searches folder, select the Deleted Quality Change Requests to locate the soft-
deleted QCR you want to hard-delete. 

2. Select and open the soft-deleted QCR you want to hard-delete. 

3. Click the Delete button in the toolbar.  

Or right-click in the QCR window and choose Delete from the shortcut menu. 

The QCR is now hard-deleted from the database. 

Note Hard-deleting an object releases its number to be reused if needed. 

To hard-delete a soft-deleted QCR in Web Client (if you have the appropriate privileges): 

1. Find the soft-deleted QCR you want to hard-delete. 

From the Recycle Bin Searches folder, select the Deleted Quality Change Requests to locate the soft-
deleted QCR you want to hard-delete. 

2. Select and open the soft-deleted QCR you want to hard-delete. 

3. Click Actions | Delete. 

The QCR is now hard-deleted from the database. 
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Note Hard-deleting an object releases its number to be reused if needed. 
 

Undeleting a QCR 
Since soft-deleted objects still exist in the database, you can undelete them if you have the 
necessary privileges. 

To undelete a QCR in Java Client (if you have the appropriate privileges): 

1. Find the soft-deleted QCR you want to undelete. 

From the Recycle Bin Searches folder, select the Deleted Quality Change Requests to locate the soft-
deleted QCR you want to undelete. 

2. Select and open the soft-deleted QCR you want to undelete. 

3. Click the Undelete  button in the toolbar. 

You can also right-click in the QCR window and choose Undelete from the shortcut menu. 

The QCR is now undeleted from the database. 

To undelete a QCR in Web Client (if you have the appropriate privileges): 

1. Find the soft-deleted QCR you want to undelete. 

From the Recycle Bin Searches folder, select the Deleted Quality Change Requests to locate the soft-
deleted QCR you want to undelete. 

2. Select and open the soft-deleted QCR you want to undelete. 

3. Click the Actions | Undelete. 

The QCR is now undeleted from the database. 
 

Closing a QCR 
If you have the appropriate privileges, you can close a QCR (promote it to its Complete type status). 
Typically, when a Change or an ECO related to a QCR is released, the Quality Administrator 
determines whether that QCR is resolved and can be closed. 

You can close QCRs (promoted to their Complete type status) in the following ways: 

à Users with appropriate privileges can manually close a QCR. 

à Closing is handled by setting the Rule on Relationships tab of the QCR. Once the criterion is met 
the QCR result is closed. 

 

Actions Menu in a QCR 
The Actions Menu provides you with a list of actions that you can perform on the QCR such as: 

à Bookmark: Saves the QCR as a Bookmark for future retrieval. 

à Subscribe: Subscriptions enable you to notify Originator of the changes in the objects. Needs 
necessary privileges. 
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à Save As: Saves the QCR with all editions for future retrieval. 

à Delete: Deletes the QCR. 

à Copy URL to Clipboard: Takes you to the location you were in by copying the URL to the 
Clipboard. 

à Print: Prints the QCR. 

à Export: Exports the QCR to a delimited text file (CSV) or to a Microsoft Excel Workbook. 

à ges. Send: Sends the QCR to other Users who have the necessary Roles and Privile

à s other Users to share the object. Needs necessary privileges.  

à 
y  from the QCR. The change allows you to release 

y  this QCR, the newly created Change will be added to the 

y nt trigger to move the QCR to specific status in workflow when the 

tate the workflow of the QCR is in. 

Creating a Change from a QCR 
ix 

blem. The Change you create from the QCR will be added to the Relationships tab of the 

1. ge, right-click on a non-tab portion of the object window 

2. ange object type from the Type list. You can select MCO, ECO, ECR, Deviation or 

3. ber field, type a number or click the AutoNumber button 

Sharing: Enable

Create Change:  
You can create a Change directly
change order to fix the problem. 
When you create a Change from
Relationships tab of the QCR.  
You can set the eve
QCR event occurs. 

à View Workflows: Allows you to view the current s
 

You can create a change directly from the QCR, which allows you to release a change order to f
the pro
QCR. 

To create a Change from a QCR in Java Client: 

Open a QCR and in the QCR Cover pa
and select Create Change menu option. 

Select a Ch
Stop Ship. 

In the Num  to automatically enter the 

4. 

ows up in both the Affected Items 
tems, then the list will only display that item once). 

ips 

es, each containing different Items). 

number. 

All affected items of QCR and PSR are listed in the Add Affected Items to Change table. Select 
item(s) from the list of Affected Items and PSR Items. If an Item is already associated with a 
Change, it is still appears in this list so that you can initiate multiple changes related to one 
Item.  The list will only show unique items (if the same item sh
and PSR I

5. Click OK. 

Agile Java Client creates the Change and the newly created Change is added to the Relationsh
tab of QCR.The Items selected will be copied over to the Affected Items tab of the Change (This 
allows you to separate the QCR into multiple Chang

To create a Change from a QCR in Web Client: 

1. Open the QCR and select Actions | Create Change menu option. 
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2. Select a Change object type from the Subclass list. You can select O, ECO, ECR, Deviation
or Stop Ship. 

 MC  

3. In the Number field, type a number or click the AutoNumber button  to automatically enter 
the number. 

All affected items of QCR and PSR are listed in the 4. 

ltiple changes related to one 
t will only show unique items (if the same item shows up in both the Affected Items 

tionships 
tab of the QCR. The items selected will be copied over to the Affected Items tab of the Change (This 
allows you to separate the QCR into multiple Changes, each containing different Items). 

Add Affected Items to Change table. Select 
item(s) from the list of Affected Items and PSR Items. If an Item is already associated with a 
Change, it is still appears in this list so that you can initiate mu
Item.  The lis
and PSR Items, then the list will only display that item once). 

5. Click Finish. 

Agile Web Client creates the Change and the newly created Change is added to the Rela
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